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1 About this Document

This software operation manual provides complete instructions for the installation, setup
and operation of the 3DVision and 3DMultiVision applications. The manual is designed for
trained personnel. Please read it carefully before you proceed.

The 3DVision and 3DMultiVision programs differ only in the activation code and method.
Once installed, the 3DMultiVision will support multiple-site and multiple-vessel projects
free of charge for a period of 30 days. When the free trial period expires, the software
turns back into 3DVision, and allows viewing and monitoring only the first site and the first
vessel defined in the system. Once the 3DMultiVision license code is purchased and
activated, the 3DVision installation turns back into 3DMultiVision which supports an
unlimited number of sites, vessels, scanners and remote clients.

By default, this manual refers to a single-vessel 3DVision application that requires no
license. All information provided in this manual is equally related to both 3DVision and
3DMultiVision application licenses, unless otherwise indicated.

For information on upgrading from the 3DVision license to the 3DMultiVision license,
please contact BinMaster.

1.1 Symbol in use

The following symbol indicates different sections of additional information as
follows:

IMPORTANT: An indication for additional information, tips, hints or an indication
of additional, helpful knowledge.

1.2 For your safety

Authorized Personnel

All operations described in this manual should be performed by authorized trained
personnel only. For safety and warranty reasons, any internal work on the
3DLevelScanners must be performed by manufacturer authorized personnel only.

Appropriate Use
The 3DLevelScanner is a device designed for continuous level or volume measurement.
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About this Document e For your safety

Warning About Misuse

Inappropriate or incorrect use of the scanner can give rise to application-specific hazards,
e.g. vessel overfills or damage to system components following incorrect mounting or
adjustments.

General Safety Instructions

The 3DLevelScanner is a high technology device which requires strict observance of
standard regulations and guidelines. The user must take note of the safety instructions
detailed in this manual, as well as country-specific installation standards (e.g., the VDE
regulations in Germany), and all common safety regulations and accident prevention rules.
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2 3DVision / 3DMultiVision Overview

3DVision/3DMultiVision enables real-time assessment of bulk solids and powders stored in
storage vessels of any type and size. 3DMultiVision provides accurate and periodical
information, providing you with essential, real-time data required for critical decisions
necessary for successful plant management.
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Figure 1: 3DMultiVision Output Example

3DMultiVision works in conjunction with BinMaster 3DLevelScanner non-contact
volumetric scanner and MVL (Multi Scanner) systems for providing measurement data to a
Windows® based computer running the programs. The program continuously collects data
from the monitored vessel and generates reports which can be used to increase
operational efficiency, and provides the site managers with valuable real-time and
historical information for effective decision making.

3DMultiVision allows usage of the same functions on groups of vessels, even across
multiple sites. In conjunction with 3DLevelScanner non-contact volume scanners, the
3DMultiVision collects data from all monitored vessels in all sites and geographic regions,
combines and merges the data, analyses and generates reports of various types.
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3DVision / 3DMultiVision Overview e System Overview

Managers and staff with the appropriate authorization levels can view this information
anywhere on the globe over a common LAN, WAN or wireless communication.

2.1 System Overview

With its Client-Server architecture, 3DVision/3DMultiVision allows multiple access for
computers connected on the same LAN or via external connections (WAN) for viewing all
data related to the connected 3DLevelScanners and MVL systems in a single site or
across multiple geographical sites.

The 3DVision Server is running as a process on a dedicated computer which manages all
connections to scanners in a single, local site or in multiple remote sites. In addition, the
3DVision Server functions as a management process for MVL systems running on an
industrial computer (also referred to as MVL Controller).

The 3DVision Server collects all data from the connected scanners. The data is being
stored on the server computer which generates the reports and transfers the information to
all connected 3DVision clients.

The 3DVision Client is a graphical and interactive program linked to a 3DVision Server,
allowing the user to receive on-line data from scanners, view a 3-dimensional profile
representation of the material stored in the vessels, add or remove sites, vessels and
scanners and manage alerts and reports.

The 3DVision Client supports several authorization levels of different privileges, starting
with full-management authorized system administrators through technicians to view-only
operators with no ability to modify parameters.

2.2 System Requirements
The following are minimum system requirements for the server and client installations.

Server

Processor: Intel Dual Core and above
RAM Memory: At least 1GB

Hard disk: At least 1 GB free space per
year (2.8 MB per day for log files)

Graphic resolution: Minimum 1024X768

Interfaces: Ethernet NIC card, serial port,
USB port

Operating systems: Windows XP (SP2)
or Windows 7

Client

Processor: Pentium 1GHz and above
RAM Memory: At least 1GB
Hard disk: At least 1 GB free space on HD

Graphic resolution: Minimum 1024X768

Interfaces: Ethernet NIC card CDROM drive
or USB port

Operating systems: Windows XP (SP2) or
Windows 7

Microsoft® .NET framework 3.5 SP1

6 3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved



3 Installing the Software

Upon completion of the recommended preparations listed under Prerequisite Information
below, the 3DVision program is ready to install.

Prerequisite Information

Make sure to gather the following information related to each 3DLevelScanner connection
prior to software installation and scanner connections:

= Polling address of each 3DLevelScanner [00 - 63]
= Method of connection to the 3DVision Server Computer

= Product information — Density (for accurate weight measurement) and the product
name

For more information on various methods of connecting to the 3DLevelScanner,
refer to BinMaster 3DLevelScanner hardware installation manual.

For more information on performing the hardware configuration, see the
document 3DLevelManager Operating Instructions.

3.1 Installation

If you are using the MVL Controller PC system, the 3DVision application is already
installed on the Controller. Skip to Starting 3DVision on page 13

It is recommended to have an active internet connection during the installation
process, as updated versions of .NET and other components may exist.

IMPORTANT: Do not install the Server application on remote computers. It is not
necessary and may result in slow operation.

To install the software:

@ Insert the software CD into the CD drive, or download the installation file from the
BinMaster USB flash drive and execute the “3DVision 1.6.5 setup.exe”
application.

@ The installation application should run automatically. The 3DVision setup wizard
opens. If it doesn't, run the installation application by double-clicking the installation
application icon.
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Figure 2: 3DMultiVision Installation Wizard

@ If the computer where the 3DVision is being installed does not have Microsoft® .NET
Framework 3.5 SP1 installed, the 3DVision setup wizard automatically detects and
prompts you to install this component. The installation file of the .NET Framework is
provided in the CD or USB flash drive supplied with the software and with the MVL
Controller.

Pressing Cancel stops the installation process and closes the window.
Pressing Next leads to the End User License Agreement step.

Click Next.
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Figure 3: 3DVision Installation Wizard - License Agreement

@ Press Print to send the End User License Agreement to the local printer.
Select "I do not accept...” to cancel and exit the installation.
Select "l accept...” and press Next to proceed with the installation.
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Figure 4: 3DVision Installation Wizard - Customer Information

@ Type in the user name and company name and choose:

= Anyone who uses this computer (all users) to make the software available to
all the computer users.

= Only for me to make the software available to the present user account only.
Click Next to confirm and continue to the next step.

Click Back to return to previous step or click Cancel to stop the installation.
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Figure 5: 3DVision Installation Wizard - Setup Type

@ Select Complete and press Next to install the 3DVision with all available features.
The installation wizard will complete the software installation.

Select Custom for remote client installations, and press Next to change the
installation folder and to select applications to install.
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Figure 6: 3DVision Installation Wizard - Destination Folder

@ For changing the default installation folder (if required), press Change.
Click Next to continue with the installation.
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Figure 7: 3DVision Installation Wizard - Application Selection

Check the required options for the applications to be installed. You may choose
installing a 3DVision Server only, a 3DVision Client only or both.

ﬂ NOTE: When installing a remote client, install the 3DVisionClient only.

Click Next to install the selected applications.
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Figure 8: 3DVision Wizard - Installation Completion

@ Click Finish to close the installation wizard and to start working with the 3DVision.

Following a successful installation, the installation package will create the following

shortcuts on your desktop per the applications installed (3DVision Server, Client or both).
A shortcut will be placed in the Startup folder in Program Files.

= o

Figure 9: 3DVision Server and Client Desktop Shortcut Icons
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4  Server-Client connection

For first time configuration, we recommend installing both 3DVision Server and Client on
the same computer. However, it is possible to install the 3DVision Server and Client on
different computers and make connection accordingly.

When executing the 3DVision Client for the first time, the system will first ask for details
required for establishing of the connection to the 3DVision Server. Following a successful
connection, a new window pops up asking for setting a user name and a password. The
default user level is Administrator, with a default user name: admin and password: admin.

4.1 Introduction: Client — Server architecture

The 3DVision / 3DMultiVision software uses two types of components: a server and a
client. During software installation, the installation package offers the option to install
server and/or client on each computer.

The server, which is the heart of the system, must be installed only once in a project. It
should be installed on a computer physically connected to all scanners in the project,
directly or remotely. The server computer should be running and logged at all times. It is
managing all communications with the scanners, collecting and storing readings and
sending configuration parameters to the scanners. The server does not have significant
options for user interaction. Rather it communicates with the client stations which are the
means for users to interact with the system.

inernat- ——

INTERNET
Extarnal Static IP -

3DVision Server Computer Address —

212.235.113.27 J Z
“ Router riernet

Local IP Address

192.568.1.100
Pon 22222

Local Clients (LAN)

Figure 10: 3DVision Computers Topology
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Server-Client connection e Starting 3DVision

The client software is the means for the user to interact with the server, and through it, with
the entire system. Multiple clients can be installed on different computers for users working
with the system. All configurations, project definitions, reports, log viewing and user
actions are done using the client software, which sends and receives the corresponding
transactions to and from the server respectively.

L]
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Figure 11: 3DVision Server Connection example

4.2 Starting 3DVision

@ Double click the “3DVision Server” icon to start the Server 9 @ *® B2
application. The server application may need a short period
(a few seconds to about two minutes if MVL type units are *
included) to initialize communications with the scanners and clients. Make sure the
server icon appears on the task bar as shown above.

The server should remain running. Manually running the server is required only if the
computer is being restarted and the server does not start automatically.

Double click the “3DVision Client” icon to start the Client application. The software
starts and the Server Connection dialog box appears.

On the first connection attempt, the Server Name and Server Address fields are
empty and require typing in of the relevant details. The connection information is kept
and will not be required on further connections. Press Connect.

® ©
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Figure 12: Server Connection dialog

In the Server Name field, enter your own description for the system managed by that
server.

In the Server Address field, enter the IP address of the computer running the
3DVision Server:

= |f both Client and Server programs are installed and running on the same
computer, enter the computer local IP address, or type in "localhost".

= |f the Client program is running on a remote computer, enter the IP address of
the computer running the server.
In the Server Port field, verify that the server port is set to 22222.

Click Connect. The application connects and a login dialog appears.
W Sentch User u

| BINHASTER ... |

o) =

Figure 13: Login dialog

@ Enter your username and password. The default username and password are both
"admin" (case sensitive).

various user accounts prior to setting up projects in the system. Refer to page
43: Tools Menu / Users Management for a detailed description. At least one user
account must have the administrator permission level.

NOTE: For logging-in to the system directly in technician mode, enter the
technician mode username and password. For further details, refer to page 43:
Tools Menu / Switch User.

n IMPORTANT: Define the user names, passwords, and permission levels of the

14 3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved



5 First-Time Running

Following a successful login, the software automatically opens the last project. If no project
exists, a hew project can be created by pressing the New Project icon in the center of the
screen or by selecting File>New...

New Project

' Create new peopect and (onfigues Jie

Eg‘!ﬂ Open Project

Open project on Sexves

3L 0 definition

O Froject” o
“New Project” option pen Froject” option,

New Project Open Project

Figure 14: New and Open Project Buttons

5.1 Starting a new project
@ Click New Project. The Wizard window appears.
B Wavs (==
Project Ganeral
BMUSTER . e

er-Castact Do Prarvitey

30Level Measurement™

) fowne] o)

Figure 15: Project Wizard - Site Name

@ In the Name field, enter a name for the new project.
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First-Time Running e Starting a new project

In the # Sites field, enter the number of sites the project should manage (each site
may contain multiple vessels).

Click Next.

one Site and one Vessel only. An upgrade to the 3DMultiVision version is
required for configuring more than one site. Contact your local BinMaster
representative for purchasing a license key for upgrading to 3DMultiVision.

n IMPORTANT: If you are running the 3DVision application you can specify

B v e
Site¥ i/
B’N_ Genenl
—=MASTER
Cannectian Type
& man
Configuration
: et (oW |8
.
Sor Gt Durt-Pont vt
3DLevel Measurement™

Figure 16: Project Wizard - Site Connection

@ Type in the Site name (limited to 16 characters) and enter the number of vessels in
the site and the number of scanners in each vessel. Editing a site, vessels and
scanners are possible on a later stage.

Set the connection type between the 3DVision Server computer and
the scanners in the site. HART modem (limited to one scanner on a
COM port), and RS-485 selections are available. Choose the proper
serial com port for the server PC connection. Click Finish. The new
project is created and the project window appears (Figure 17). A
selector box appears on top for each vessel in the project as shown to the right.

individually defined with its number of vessels, the number of scanners in each
vessel, connection method and serial COM port. Clicking Next switches to the
next site. Repeat site configurations for all sites. In the next example, only a
single site is defined.

n NOTE: When a project includes more than a single site, each site should be

16 3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved
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Figure 17: The project window

The project window is built according to the project hierarchy of Sites > Vessels >
Scanners.

Multiple sites of the project may be defined. The defined sites will appear, and can be
selected from the sites navigation bar on top. When selecting a site, its relevant
information and configuration options appear at the main area, organized in two tabs:
Vessels and Logs. Refer to page 23: Main Software Screen for display area descriptions.

Multiple vessels may be defined per each site. The vessels are represented by icons
appearing on the vessel navigation bar. When selecting a site from the site navigation bar,
the corresponding vessels are shown on the vessel navigation bar, where a vessel can be
selected. Selecting a vessel causes the main view to display various types of information
and configuration options related to that vessel at the main area under the vessel
navigation bar, organized in different tabs: Overview, Logs and Parameters. Right-clicking
a vessel icon opens a menu with different options related to that vessel. Note that the
menu options are different if the selected vessel is left-clicked.

Multiple scanners may be defined under each vessel. A scanner can be selected and
accessed using a drop-down list which appears on the right-hand corner of the window
under the vessel navigation bar, per the selected vessel.

NOTE: Selecting a scanner for configuration under a specific vessel can be done
only by logging in as a user with technician privileges.

3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved 17
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5.2

Vessel Properties Configuration

The example below shows how to configure a single site with a single vessel with 2
3DLevelScanner model MVL devices.

n NOTE: In order to configure a vessel with more than one scanner, all scanners

must have an MVL license code. Contact your local BinMaster representative for
purchasing a license key for upgrading to 3DMultiVision.

Vessel Properties Configuration

@ Select the vessel selector box and right-click the vessel name. Select Property...

From the drop-down menu. The Edit Base Properties box appears (Figure 16). Enter
the vessel name and description, and click OK.

| 3 Edit Sase Properties m

Figure 18: Edit Base Properties box

Double click the vessel image to open the vessel measurements and details pane
(see Figure 17). The "Overview" tab shows how many scanners are set for this
vessel and their connection status.

logged in has technician privileges, a "Scanner" labeled drop-down list appears

n NOTE: If the selected vessel contains more than one scanner and the user

at the top-right corner of the screen, see Figure 19. Select the required scanner
for configuration from the dropdown list.

@ Click Parameters to open the Parameters tab and to configure the scanner

parameters (Figure 18). Choose the Connection Type (HART, RS-485 or TCP/IP.
Other unsupported types are visible but not selectable), the Serial COM port and
polling address.

18
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Figure 19: 3DMultiVision Vessel Overview pane
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Figure 20: Scanner Parameters tab
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@ Configure all the scanners set for the vessel by selecting them from the scanners list
and entering their communications parameters.

@ Once all scanners are configured, connect to all the scanners in the vessel by right-
clicking the vessel name and selecting the Connect option from the drop-
down menu. For more options and details, refer to page 42: Appendix A:
Software Menus and to page 22: Software Navigation.

When a connection is established, click the site selection box on top of
the screen (as shown to the right). The vessel profile screen appears
(Figure 19), with the results of the scanned measurements.

2D 30 M e (b - thareesbeil) - Nen Pragter L= B -

3D MultiVision

" = - T L

| Scwvvers Sevwwt D vrsveve{rmpivted 20110055 104353

Figure 21: Vessel Profile

To view a 3-dimensional profile, right-click on vessel measurements figure (the
bigger vessel figure) and select show 3D profile (see Figure 22: Product 3-
Dimensional Profile).

20 3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved



First-Time Running e Vessel Properties Configuration
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Figure 22: Product 3-Dimensional Profile

NOTE: When connecting to MV/MVL type vessels, an option of viewing the 3D
Profile of the product in the vessel is available by double clicking the vessel
image.

For more information on the 3D Profile, refer to page 37: 3-Dimensional
representation.
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6 Software Navigation

This chapter provides an overview of the various toolbars and menus as well as an
overview of the projects.

6.1 Project Overview

The 3DMultiVision software allows defining different projects. Each project is organized in
the following hierarchical structure:

= Top Level: The project.

= Second Level: A list of sites.

= Third Level: A list of the vessels located at the site.

= Fourth Level: A list of the scanners associated with each vessel.

For example, a single project may include multiple sites (or multiple groups of vessels),

where each site / group may contain multiple vessels, with one or more scanners per
vessel.

The example shown below describes a single site called Manual, which includes a single
vessel named Silo 306 with 2 scanners of type MVL.

’
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Figure 23: Project Overview Example

®m  Site Selection (located on center-top area of the screen):
Allows navigation among defined sites. The figure to the

Marus | Sie3 Saup e
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right shows a project with 3 sites, named: Manual, Site 3, Group 52.
To edit/add or remove sites use the Edit menu (refer to page 43: Edit Menu).

The site selection also allows viewing 3-dimensional profiles of more than one vessel.
Right click the vessel measurement figure and select the Show 3D profile option. A
window appears, showing the 3-dimensional image. Multiple 3-dimensional profile
windows can be opened at the same time, however only the yellow-framed one
displays real-time parameters.

Vessel Selection: Allows navigating among
vessels defined in a site. The figure to the
right shows a site with 4 vessels: Silo 306,
Silo 307, Silo 308 and Silo 309.

For editing, adding or removing sites use the Edit menu (refer to page 43: Edit Menu).

Scanner Selection: Use this option to set the scanner polling address, communication
method and properties.

6.2 Main Screen

Main Software Screen

[——

Figure 24: Main Screen

The main screen major areas are:

1

Main menu: Includes the software main menus: File, Action, Edit, Tools and Help.
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2 Project toolbar: Includes various tools for project management and operations,
including project opening and saving, connection to sites and data loading.

3 Site selection bar: A project allows multi-site management, where each site may
include multiple vessels. The selection bar allows selecting a site for monitoring and
operations.

4  Vessel selection bar: Lists all vessels included in the site selected from the Site
selection bar. Allows selecting a vessel for monitoring and various operations.

5 Scanner selection list: Automatically populated with all scanners included in the
selected vessel. Allows selecting a scanner for monitoring and various operations.

6 Control tabs: Includes tabs related to the selected item (site, vessel or scanner).
Each tab switches the work area (below the tabs) according to the tab's function.

7 Main work area: Provides graphical and textual information and properties, and
different modification and control options related to the selected item (site, vessel or
scanner) and according to the selected tab above it.

8 Status bar: Displays actual information related to different operations done, such as
downloading data and connection.

6.3 Main Toolbar

The 3DMultiVision toolbar allows various project control operations.
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Figure 25: The Toolbar

BOp'eh... Open: Opens an existing project for local browsing.

,Save Save: Saves the present project. Change in the existing
; project must be saves for the changes to take effect. In the

title bar, next to the name, a (*) will appear whenever a
change is made. It disappears on saving the project.

- Level/Distance Data: Allows choosing the measurement

type displayed (level or distance). Displays the
measurement of material in the vessel by either Level or
Distance.

Distance refers to the distance of the material from the
scanner. Level refers to the level of material measured from
the bottom of the silo.

The selection applies for measurements in all viewing
panes, at all view levels, for the corresponding values (min /
max / average). Click the button to toggle between distance
and level display.

O Connect Vessal Connect Vessel/Scanner: Connects the selected Vessel or

3DLevelScanner device (whichever is selected) to the
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3DMultiVision application.

€I Discohhedt Vessel Disconnect Vessel/Scanner: Disconnects the selected
S Vessel or 3DLevelScanner device (whichever is selected)
from the 3DMultiVision application.

@Load fom Vessal Load from Vessel/Scanner: Manually download all
S measurements from the selected vessel or 3DLevelScanner
(whichever is selected) to the 3DMultiVision application. All
data is automatically downloaded, from all scanners for all

vessels to the server.

{Sart By | Al ~| Sort By: Sorts the vessels by different groups: All, Material,
— " Name and All Same Size.
= All: Displays all vessels in all sites, ordered by the 3
major sizes: large, medium and small.

= Material: Displays the vessels ordered by their material
name.

= Name: Displays the vessels ordered by their names.
= All Same Size: All vessels are displayed at the same
size.

= Manual 4x4, 5x5, and 6x6: Sets the order of vessels to
the selected grid.

= Manual: Sets the grid as defined in Tools/Configuration
menu.

When selecting a sorting option other than All, the site
display changes and shows the vessels in groups, arranged
according to the sorting criteria, as shown in the following
image:

Figure 26: Sort By Name view

The Manual sorting options displays the vessels in different

3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved 25



Software Navigation e Main Toolbar

sizes, according to the selected option. The sizes are
smaller and may be more convenient when managing a
large site. For example, selecting Manual 4x4 shows the
vessels as follows:

Figure 27: Sort By Manual

Use the Tools / Configuration option to define the Manual
matrix type (rows and columns) used for displaying the
vessels.

@ Cofinectad Connection status: Indicates the client connection to the

server. See page 35: Alert types.

Vessel selection behavior

Vessels are displayed in blocks in the main area under the vessel selection bar. Each
vessel is represented by a rectangle with the following items:

The vessel image with the material stored at the selected material color and at its
current level

Stored material name and scanner model
Empty and full levels represented by red and orange lines respectively

Level measurements: Current level, maximum level and minimum level using the
configured measurement units, and volume in percents

A status indicator. Note that in the case of a failure, the indicator and the entire
background of the rectangle becomes red.

Double-clicking the vessel rectangle replaces the display and brings up the detailed vessel
tabs in the main area, with the Overview tab selected.

Left clicking the vessel rectangle opens a menu for quick-access to the following features:

Show 3D Profile: Pops-up a 3-dimensional profile window.

Material Selection: Opens the material management box which allows choosing a
different stored material for that vessel.

Properties: Brings up the Material property box, which allows choosing the visible
material properties in the representing rectangle and the alert types to be used for
that vessel. Refer to page 35: Parameters and Alerts for further details regarding
alerts.

26
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A single mouse left-click selects the vessel. The selected rectangle becomes outlined with
a yellow frame, and the corresponding vessel icon in the vessel navigation bar is selected.

When right-clicking a selected vessel, the menu opens but its contents are different, and
the following options are added:

Connect / Disconnect: connect or disconnect communication from the selected
vessel scanners to the server.

Load from Vessel: loads data from the vessel scanners and updates the displayed
status and parameters.

Edit: allows adding a new scanner to the selected vessel or deleting the entire vessel.
Generate report - Download from Server: Opens a date/time selection box for
selecting report date and time, downloads the corresponding historical data from the
server and opens a file browser box for choosing the report file location.

The report file is being created in PDF format, and includes the date, time, project and
vessel details and volume / mass and alert parameters for the selected date and time.
The report also includes 3-dimensional representations of the corresponding vessel.
Generate report — From local folder: opens a folder browsing box for choosing the
folder where the related data is stored. Creates a report as described above, but per
data stored locally.

6.4 Vessel Pane
The Vessel Pane includes different monitoring options and allows performing basic vessel

operations (see Figure 22).

i
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Figure 28: Vessel Pan
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Overview tab
Selecting the Overview tab switches the main area below to display two panes.

The left pane includes the vessel connection information, alerts, measurements and
indications related to the selected vessel:

= Vessel name, connection status of the vessel and selected scanners.
= Alerts, if they exist.

= Scanner names, versions and communication details

= Minimum Level/Distance.

= Maximum Level/Distance.

= Volume (%).

= Mass (if density is defined).

= Temperature.

= SNR.

= Scanner Output Current.

®m A graphical representation of the vessel, including the vessel shape, maximum and
minimum levels and connection status indicator.

= Material button: allows choosing the material contained in the vessel. Pressing the
button brings up the Material selection window which allows managing of the
materials with their names and colors, where the material can be chosen out of a pre-
defined list of materials and their representing colors (Figure 29: Material Selection

Window).
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Figure 29: Material Selection Window

When a scanner is selected from the scanners list, its information is also displayed:
= Scanner Name.
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= Connection Type.

= COM Port.

= Polling Address.

= S/N - Serial Number of the electronic card.
= Hardware Version.

= Firmware Version.

= Scanner Type - Type of 3DLevelScanner.

Logs tab

The Logs tab provides a chart representation of historical measurements data, and allows
different manipulations for chart inspection. For further details, refer to page 39: Log views.

Parameters tab

Selecting the Parameters tab switches the main area below to display vessel shape
parameters: top shape, center shape and bottom shape, and their dimensions.

Scanner Parameters
When a scanner is selected, the scanner parameters are displayed.
You must define the connection settings for each scanner in the project.
For each scanner in the vessel, the Parameters tab allows defining the following:
= Connection Types:
- HART
- RS-485
- TCP/IP
= Configuration details:
- Serial Port

- Polling Address
For example: In Figure 20: Scanner Parameters tab, the connection to the scanner is set
to RS-485 type connection; serial COM Port 4 and polling address 00.

For a more detailed explanation of how to connect to a 3DLevelScanner in various ways,
refer to the 3DLevelScanner hardware installation manual.
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7 Advanced Tools

This chapter describes several useful tools for configuration, system administration and
reports handling.

7.1 Advanced Reporting Features

The 3DMultiVision software offers a wide range of report types of different levels and
content.

In the main menu, select Tools » Reports to access the report options.

Report configuration

From the Reports menu, select the Configure... option. The Report Configuration window
appears (see Figure 30: Report Configuration window). The Report Configuration window
allows the following options:

®m  Setting report creation time:

Multiple reports can be generated at different times during the day. Adding a creation
time is done by setting the required time on top-right time entry field, and clicking Add.
The new creation time will be added to the list at the top left.

Clicking the Set Default button will set the selected creation time in the list to be the
default value for further configurations.

The Every Hour button automatically generates a list of creation times every hour
during the day.

The Delete button deletes the currently selected creation time from the list. The
Delete All button clears the list.

®  Setting report repeating generation options:
Report creation may repeat itself at the following options:
Daily: The report will be generated every day at the creation time set above.

Weekly: The report will be generated once a week at the creation time set above and
the Week-Start Day selected.

Monthly: The report will be generated once a month only at the creation time set
above and the first Week-Start Day selected.

®  Setting data types to be included in the reports

The report will include data types combined of the checked options: Distance, Level,
Volume [%], Volume (absolute) and Mass.

®m  Selecting report related folders and file formats
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Each report can be included in its own directory, which is created automatically. To
enable automatic directory creation, check the Report Directory Creation checkbox.
Reports which are saved on the server computer will be stored in the directory set in
the Server Reports Output Directory field. To change directory, click the [...] button
and chose a different directory from the browse box that opened (executed on the
server computer).

The software allows choosing the application to open stored report files, such as
Excel. For choosing a different application, click the [...] button and select the desired
application. The selected application must support the Excel (.xIs) file format.

Click the Save button to save the updated report settings.
Click Cancel to exit and discard any changes made.
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Figure 30: Report Configuration window

Hardware Inventory Table

This system allows creation of a special report called Hardware Inventory Table, which
lists the following:

= All sites included in the project with their names, descriptions and server names.
®  For each site, the included vessels are listed with their names.
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®  For each vessel, the scanners related to that vessel are listed under it.
The table contains the following properties per the included items: Vessel, Serial number,
Hardware and firmware versions of the scanners, Polling address, Scanner model and
Connection type for each scanner.

To activate the Server Inventory, select Tools » Reports » Inventory Summary Table. The
table appears (see Figure 31: Hardware Summary table).

The Refresh button can be pressed any time to view updated contents.
=)

N e ey
Noww T v e— I e e =
e D ARt T e S L M
' T
v
B )
. b0 wah
= S rn Saanor Pyt Saec tute 1
ani

. s e t— e Ye T Y
-

Figure 31: Hardware Summary table

Measurement Summary Table

Another special report is the Measurement Summary Table, which lists the Volume
(absolute), Volume %, Mass and Alerts for all vessels on all sites, grouped by site.

The table lists the measurement units reported by the scanners.

To activate the Measurement Summary, select Tools - Reports - Measurement Summary
Table. The table appears (see Figure 32: Inventory Summary table).

The data displayed can be updated anytime by pressing the Refresh button.
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Figure 32: Inventory Summary table
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7.2 Demo Mode

The Demo mode is highly useful for demonstration and marketing purposes, and for
understanding system operation.

The Demo mode loads a demo project with pre-defined sites, vessels and scanners and

their configuration, and activates a simulation of filling / emptying operations over time.

Most software features are available in demo mode, thus it allows viewing reports, 3-

dimensional profiles, logs and time-based charts and their behavior over time.

= Select Start Demo Running from the Tools menu to initiate the demo mode. A demo
project selection box appears. The box includes demo projects of various types, such
as Aggregates, Chemicals, Food and more. Choose a demo project and press
Select. The demo project will load with all its sites, vessels and scanners, and the
simulation will start.

= Fast Run / Normal Run / Slow Run: The demo mode simulation is running at an
accelerated time. The simulation speed may be chosen as one of these options. By
default, the Normal Run option is selected.

= Restart Demo Running brings the demo values to their initial levels and continues
the simulation while keeping demo history.

= The Reset Demo Date (Server) option restarts the demo.
= To exit demo mode, select Stop Demo Running from the Tools menu. The demo
mode stops and a project selection box appears.

IMPORTANT: The demo mode must be stopped before the system can return to
normal operation. Exiting and restarting the application will not stop the demo
mode.

7.3 Users Management

The 3DVision / 3DMultiVision software allows several user levels. Each level has different
authorizations for accessing system features. Multiple users can be added to the system
and their authorization level should be set.

The available user level options are:

= Administrator — Has all privileges except for changing scanner’s communication and
polling address

= Premium - Same as Administrator, without the privilege of changing user accounts.

®  Technician - Full control

= Viewer — Only viewing capabilities

To access users’ management, select the Users Management option from the Tools

menu. The User Management box appears and allows adding and deleting users and
setting their user name, password and authorization level.

The Users Authorization is Enabled check box on top, when unchecked, causes the
server to ignore the defined user authorizations, which allows entering the system without
a password. All users log in with Administrator privileges.
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7.4 Materials Management

The software includes a convenient tool for managing stored materials which are
represented by names and colors. Materials can be added to the project as required with
their names defined and their colors chosen. When setting up vessels, the stored material
is selected out of the list of materials created using this feature, and the color chosen for
the selected material will be used to represent the vessel in the vessel display under site
selection and whenever a graphical vessel representation is used.

For creating a new material, choose Configure Material Color from the Tools menu. This
brings a similar dialog which also includes the options to add, delete or modify and store
materials, their descriptions and colors, as shown below:
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Figure 33: Material Color
To add a new material:
= Enter the new material name in the Material Name box.

= Select its color by pressing the [...] button. A color selection box appears. Select the
desired color. The vessel image will automatically change to display the stored
material with the selected color. Close the color selector box.

®  Press the Add button. The new material will be added to the list.
For editing the material details:

®  Select the material to be modified from the Available Materials list, enter a new name,
or select a different color and press the Edit button.

For deleting a material, select it from the list and press the Delete button.
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7.5 Parameters and Alerts

The system allows defining and displaying alerts of various types. Alerts are shown using
a circular indicator located on the vessel icons in the vessel navigation bar, the vessel
rectangular boxes displayed when a site is selected and in the vessel Overview tab. In
addition, the vessel box and the overview tab provide descriptions for the alerts.

Alert types

The system provides alerts for configuration and different notifications using the round
condition indicator:

= System Notifications — in red color. Occurs when a 3DLevelScanner measured
temperature exceeds the scanner spec temperature range (-40 to +85 °C or -40 to
+185 °F).

= Alerts may appear in different colors for various failure conditions as follows:
- Grey: No connection
- Orange: Wrong configuration warning
- Red: Serious equipment malfunctioning, usually with scanners
- Green: indicates a proper condition

= Configuration Notifications (in yellow color). Appears when the 3DLevelScanner
settings are not identical to the corresponding vessel settings (all configuration wizard
settings except device position and horizontal angle).

The alert description will be displayed above the vessel image in yellow font.
= Vessel volume alert - it is possible to set minimum and maximum volume thresholds
to alert the operator that the material inside the silo exceeded the maximum value or

is below the minimal value, such indication will turn the entire vessel box red in site
view, under the overview tab.

Choosing properties to be displayed

The software allows choosing the alerts to be indicated per vessel. To select alerts for a
vessel, right-click a vessel at the vessel rectangular box (when a site is selected) and
choose the Properties... option from the menu. The following data selection tab appears:
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Figure 34: Data Selection
The Data Selection tab allows choosing the properties to appear in the vessel box under
site selection. By default, the following properties are selected and shown:
= Distance/Level (the distance or level parameter is shown as configured)
= Maximum and Minimum Distance / Level
= Volume (%)

The box allows removing selected properties, adding properties to be displayed and
changing the order they appear when displayed inside the vessel box:

= For removing a selected property, select the property for removal and press .
= For removing all selected properties, press [

= For adding a property, select the required property from the Available pane and
press the | I* key.

= For adding all available properties, press the I'' key.

= For moving a selected property up, select the property from the Selected pane and
press the I= key.

= For moving a selected property down, select the property from the Selected pane and
press the I= key.

Setting alert threshold

The Alerts tab allows choosing the alerts threshold, which triggers an alert when the
material volume is under or above these levels.
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Alert Threshold [%]

[F] Maximum | 100

[E] Minimum: | 0

Figure 35: Alert Threshold

To define the alert thresholds:

®=  Check the required option (or both). Unchecked option will not generate an alert for
this vessel.

®  Set the value in volume percent where above this value (for maximum) or below this
value (minimum) an alert should be generated.

Once set, an alert will be generated when the material volume exceeds the maximum
value set or gets below the minimum value set.

7.6 3-Dimensional representation

The right pane of the Properties tab of a selected vessel displays a 3-dimensional
representation of the vessel including the scanners located on it and the material stored,
with the level and surface as measured by the scanners, and several control options.

The 3-dimensional image feature can also be activated when right-clicking a vessel box
when a site is selected, and choosing the Show 3D Profile option.

t

Figure 36: 3D Image

= Navigation stick: allows 4-direction image tilt and rotate over the X and Y axes,
including a central home button which brings the axis back to 0° position and resets
magnification.

= Magnification slider: allows changing the image magnification in and out.
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On Line checkbox: When checked, the image is displayed according to the current
material measurements. When unchecked, the view changes to an animation
showing the stored material level and surface changes over a selectable time period
(see Figure 37: Animation control bar).

- Play/Stop/FF/REW animation control buttons

- Time bar with location knob

- Interval: Allows setting frame rate in milliseconds

- [ 8] button: Allows changing the animation date range
- [...] button: Allows opening an existing animation file

&=
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Figure 37: Animation control bar

Additional 3D representation related functions are available by right-clicking on the image:

Show Vessel Geometry Only
¥ Show Device
Show Fill, Empty Points

Material Color ...

Show Axes

Activate Pan Mode

Save Image As...

Mizc b

Wiew b

Figure 38: 3D image properties
Show Vessel Geometry Only: Remove the material representation and leave only
the vessel shape.

Show Device: Shoes the 3DLevelScanner(s) in their configured locations on the top
of the vessel.

Show Fill, Empty Points: Add small arrow icons to represent the location of the filling
and emptying points based on the 3DLevelScanner configuration.

Material Color...: Selecting this option will open a new window with various colors to
select from and paint the material with the selected color.

Show Axes: Add X, Y and Z Axis to the Vessel shape, the center of axis is the center
of the vessel on the bottom part.

Activate Pan Mode: Selecting this option allows moving the 3D image up and down
and to the sides, instead of rotating it as the default operation.

38
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®  Save Image As...: Allows saving the currently viewed image as JPG file on the
computer.

= Misc P»: Additional functions:

Show Silo Dimensions Walls: Add grid walls with dimensions
Draw Silo Grid (Wireframe): Add grid to the material surface
Show Solid Material Color: Switch the gradient material color to a single color

Fill Bounds With Material: Fill the bounds of material and silo with the same color
as the material

Hide Top Shape: Hide the top part of the silo in case it is a cone, dome or
pyramid

= View »: Viewing the 3D image from different angles:

7.7

Original

View From Front
View From Top
View From Left
View From Right
View From Behind
View 3D

Log views

When a site is selected or when a vessel is selected and its properties are shown in the
main area, select the Logs tab to view its logs. This switches the main area below to
display logged data in historical chart representation, for both site and vessel (see Figure
39: Site Logs and Figure 40: Vessel Logs).

Figure 39: Site Logs
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Figure 40: Vessel Logs

Site Logs

Display Level/Volume based charts for all vessels defined in the site, each vessel can be
un-selected from the chart.

Vessels Logs

Collected data is displayed in four charts over a selected time period for Level, Volume,
SNR and Temperature of the selected vessel.

= For magnification of a selected area in the chart, hold the mouse left key over the
chart and drag to create a rectangular area. When releasing the mouse button, the
chart will magnify according to the selected area.

= For panning a specific location in the chart, right click the mouse inside the chart and
drag. The chart area will pan according to the dragging location.

= The [=l button allows cancelling all zoom and pan activations that were applied on all
graphs and returning back to the original display view.

®  The On Line check box:
- When checked, the charts show the current measurements.

- When unchecked, allows downloading data from the scanners or browsing for
previously stored files containing the data for displaying.

7.8 Upgrading

When upgrading from 3DVision to 3DMultiVision versions, a license key is required. The
change takes effect immediately and does not require a restart of the client PC. The
license key is given for a MAC address (unique for every computer).
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Figure 41: Update License Key dialog

= Click the Get button to retrieve the 3DVision Server computer MAC address. The
MAC address is displayed, and automatically copied to the clipboard. Send the MAC
address information to your BinMaster representative for upgrade or activation.

= Enter the license key in the Enter License key... field.

The 3DMultiVision software may be installed and operate for up to 30 days without a
license key. After 30 days, the software will require a valid license key to operate. During
the 30 days period, the software will generate licensing reminder messages from time to
time. Checking the Don't remind check box disables these reminders.

NOTE: One license code is required per a 3DVision Server application. The
license code must be generated for the MAC address of the server computer
only.
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Appendix A: Software Menus

The appendix describes the options available in each menu of the 3DMultiVision software.

8.1 File Menu
= New: Starts a new, empty project. File
= Open: Opens an existing project. e
®  Save: Saves the current project. Open..
®  Save As: Saves current project as a different name.
= Export Project from Server: Exports a project in Save
XML format. Save As.,
= |mport Project to Server: Imports a project in XML
format. Export Project from Server...

) . Dini 3 :
®  Delete Project: Deletes a project from the server. A Sporkfiofeckin Aerverc,

list of all projects stored in the server is opened for Delete Project
choosing a project to delete.

=  Browse to Local Folder: Allows browsing the
software installation folder.

®  Exit: Exits 3DMultiVision.
n NOTE: The Import and Export functions are for maintenance reasons. They allow

Browse to Local Folder...

Exit

downloading projects to a local computer for modifications, and then uploading
the modified projects back to the server.

NOTE: Deleting projects is allowed as long as there is at least one project
remaining. Deletion of the current project is not allowed.

8.2 Action Menu e

The lower part of this menu changes according to the selected
item. If a vessel is selected, it corresponds to a vessel connection.
If a scanner is selected, it displays scanner related commands, e
e.g. Connect & Disconnect Scanner, Load from Scanner. Load from Vessel

®  Connect All: Connect to all the scanners in the selected site.

®  Disconnect All: Disconnect from all the scanners in the
selected site.

®  Connect Vessel: Connects to all scanners of the selected
vessel.

Connect All

Disconnect All

Connect Vessel

Disconnect Vessel

Load from Vessel
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®  Disconnect Vessel: Disconnects all scanners in the selected vessel.
= | oad from Vessel: Downloads all the data from all scanners in the selected vessel.

8.3

Edit Menu

= Add »: Add sites, vessels, or scanners depending on the level m
selected in the project pane. Sub-menu options:

- On the site level it adds sites or vessels.
- On the vessel level it adds scanners.
- On the scanner level it is disabled.

= Delete »: Deletes sites, vessels, or scanners depending on the level selected in the
project pane. Sub-menu options:

- On the site level it deletes sites.
- On the vessel level it deletes vessels.
- On the scanner level it deletes scanners.

Add ’
Delete »
Properties »

= Properties »: Sets a name and description to a site or a vessel. Sub-menu options:
- On the site level define the name and description of the site.
- On the vessel level define the name and description of the vessel.

8.4

Tools Menu

The tools menu offers useful tools such as different reporting,
administration tools, configuration functions and demo mode.

Reports files are created and stored in Excel worksheet
format and can be opened, viewed and manipulated using

Excel.

= Reports »:

Export Present Project Reports from Server:
Allows selection of a date range, and retrieves a list
of corresponding report files (see Figure 42 below)
from the server to select from, and allows selection
of local folder to store the selected report.

Browse to selected project report folder: Opens a
file browser window at the project report files
location on the local hard drive. Available only if the
Client is running on the same computer as the
server.

Show last generated report: Opens the last
generated report Excel worksheet in Excel. Available
only if the Client is running on the same computer as
the server.

Reports
Configure Materials Color..,

Senior Technician Mode..

Connect to Server.,.
Server

Switch User.,

Users Management....
Configuration..,
Change Language
License Key...

Demo
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®m  Generate report for selected vessel»: Allows selection of report date and time,
and generates a report for the selected vessel, and stores it in PDF format. There
are two location options for retrieving the report data to choose from:

- From Local Folder: Searches the local log folder for corresponding data.
- Download from Server: Searches the server for corresponding data.

% Fies [R5
Hame

6200302 620

Sae (X1

Figure 42: Report Files selection

= Configure.... Allows report creation time, repeating options, folder and file
options configuration. For more details, refer to page 30: Report configuration.

= |nventory summary table...: Displays a special report including scanner details
for all project scanners. For more details, refer to page 31: Hardware Inventory.

= Measurements summary table.... Displays a special report of vessel storage
measurements for all project vessels. For more details, refer to page 32:
Measurement Summary.

NOTE: For opening and viewing report files on Excel format, Microsoft®
Excel® or OpenOffice must be installed on the computer.

Configure Materials Color...: Opens a window for defining new material types and
set their color, to be displayed in the vessel images. For further details, refer to page
34: Materials Management.

= Senior Technician Mode...: Allows switching to Senior Technician mode, which is
reserved to the manufacturer's engineering only.

= Connect to Server.... Connects the client to a server (if not already connected), or
disconnects the current connection and connects to a different server. A Server
Connection dialog appears. For further details regarding server connection, refer to
page 15: First-Time Running.
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Server »:

The server sub-menu contains several functions
such as server synchronization, server o
information retrieval and advanced server Server Synchronization

functions. Advanced »

Server Version

Server Version: Retrieves and displays the
server version.

Server Synchronization: Synchronizes all
parameters from the 3DMultiVision Server to
the client PC. When local changes have been made at a client level, while the
server has different values received from the scanners, this function updates the
client with the server data so both are identical.

Advanced »:

Get Server Active Tcp Connections

Get Server Active Tcp Listeners

- Ignore External Managers: The lanoe Ex{emal,Managers
3DLevelManager programs running on Fpect Coalty Sile ram Serpet,
remote computers are connected and Export Trace Files from Server.
communicate with scanners directly, and

not through a server as with the 3DVision Show Server Last Error

|/ 3DMultiVision. This causes the Show Server Computer Date and Time
3DVision / 3DMultiVision to enter silent

mode, where no data is received. Restart Server

Choosing the Ignore External Managers
option  disconnects these remote
connections and exits silent mode. This option is available under Technician
Mode only.

- Export Config Files from Server: Export a configuration file in XML format, for
support purposes.
- Export Trace Files from Server: Export server trace files for support purposes.

- Show Server Last Error: Retrieves and displays the last error reported by the
server.

- Show Server Computer Date and Time: Retrieves and displays the server
date and time. The server date and time may be important for synchronization
reasons. Client and Server computer clock might be different due to geographical
installation or a difference in clock settings.

- Restart Server: Halts server execution and causes it to restart.

Get Server TCP Connections: Retrieves and displays a list of all existing
connections to the server. Each connection displayed includes the local port,
remote port, TCP/IP address and status.

Get Server Active Top Listeners: Retrieves and displays a list of all existing
connections to the server.

Switch User...: Logs out the current user and logs in as a different user. This function
opens a window requesting the new username and password.
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NOTE: Each user account has its own defined permission level. If you
switch to a user account with a lower permission level, you will be more
limited in the actions you can perform.

Users Management...: This function opens the Users window which displays a list of

all the user accounts defined on the Server and their permission levels as shown.

Refer to page 33: Users Management for further details regarding user levels and

authorizations, this option is available to users with Administrators privileges.
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Figure 43: Users Management dialog

The Users Management dialog enables adding, removing and changing properties of
users:

Add...: Click to add a new user. A dialog opens requesting a name, password and
permission level for the new user.

Remove: Select a user for removal from the list and click Remove to remove user.

Properties: Select a user from the list for changing their properties and click
Properties. A dialog opens allowing changing the name, password and permission
level for the selected user.

Click Close to accept the changes and close the Users Management dialog.
Configuration...:

Allows changing different visual settings of the client application. When selecting this
option, the following dialog appears:

46
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3 Cient Canfigumstion

|= & bl

Site View Manual Layout
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Figure 44: Client Configuration dialog

= The Configuration dialog allows defining how vessels are displayed in the client
working area. The Number rows field sets how many rows of vessels to display.
The Number columns field sets how many vessels to display in each row.

= The configuration dialog also allows adding the customer's logo on the top-right
corner of the client application. To add/change the logo, click the [...] button. A file
browser box appears. Select your company logo file (must be of JPG, GIF, BMP
or PNG extension) and click Open, or enter the location and file name manually

in the Logo Image File field.

= Click Close to accept the changes, or Cancel to exit discarding changes.
= Change Language P : Allows selecting the preferred client language.

= license Key....
Allows upgrading from the single-vessel

3DVision software license to the

3DMultiVision software license by entering a new license key. For a detailed

description, refer to page 40: Upgrading.
= Demo b

Activates the software in Demo mode, which allows
selecting a demo site and performs a simulation of the Fast Run
operation of its various components (vessels, scanners) | v Normal Run

and creates logs.

For further details, refer to page 33: Demo Mode.

Start Demo Running

Restart Demo Run

Slow Run

Reset Demo Data (Server)

3DVision / 3DMultiVision Operating Instructions © 2011 BinMaster all rights reserved 47



www.binmaster.com

SmartBob2 weight & cable
Rotaries

Capacitance probes
Vibrating rods

Diaphragm switches

Tilt switches

Ultrasonics

Radar

Aeration

Call us for dust & flow detection devices, too!

BIMMASTER

Mailing Address:
P.O. Box 29709
Lincoln, NE 68529

Shipping Address:
7201 N. 98th St.
Lincoln, NE 68507

800.278.4241 | 402.434.9102
Fax: 402.434.9133
www.binmaster.com | info@binmaster.com

&

Distribué par:

PRECONISATEUR DE SOLUTIONS DERUIS 155

Contact :
hvssystem@hvssystem.com

Tél : 0326824929

Fax : 0326851908 A M

Siege social :

2 rue René Laennec
51500 Taissy
France

www.hvssystem.com

0/90000NVIN

©2011 BinMaster Level Controls. All rights reserved.
Information in this document is subject to change without notice.





